




CAM制作之CAM350软件学习资料

CAM 制作的基本步骤


	


每一个PCB 板基本上都是由孔径孔位层、DRILL 层、线路层、阻焊层、字符层所组成的，在CAM350 中，每载入一层都会以不同的颜色区分开，以便于我们操作。

1.导入文件

首先自动导入文件（File-->Import-->Autoimport），检查资料是否齐全，对齐各层（Edit-->Layers-->Align）并设定原点位置（Edit-->Change-->Origin-->Datum Coordinate），按一定的顺序进行层排列（Edit-->Layers-->Reorder），将没用的层删除（Edit-->Layers-->Reorder）。

2.处理钻孔

当客户没有提供钻孔文件时，可以用孔径孔位转成Flash（Utilities-->Draw-->Custom，Utilities-->Draw-->Flash-->Interactive）后再转成钻孔（钻孔编辑状态下，Utilities-->Gerber to Drill）；如果有提供钻孔文件则直接按制作要求加大。

接着检查最小钻孔孔径规格、孔边与孔边（或槽孔）最小间距（Analysis-->Check Drill）、孔边与成型边最小距离（Info-->Measure-->Object-Object）是否满足制程能力。

3.线路处理

首先测量最小线径、线距（Analysis-->DRC），看其是否满足制程能力。接着根据PC 板类型和基板的铜箔厚度进行线径补偿（Edit-->Change-->Dcode），检查线路PAD 相对于钻孔有无偏移（如果PAD 有偏，用Edit-->Layers-->Snap Pad to Drill 命令；如果钻孔有偏，则用Edit-->Layers-->Snap Drill to Pad 命令），线路PAD 的Ring 是否够大（Analysis-->DRC），线路与NPTH 孔边、槽边、成型边距离是否满足制作要求。NPTH 孔的线路PAD 是否取消（Edit-->Delete）。以上完成后再用DRC 检查线路与线路、线路与PAD、PAD 与PAD 间距是否满足制作要求。

4.防焊处理

查看防焊与线路PAD 匹配情况（Analysis-->DRC）、防焊与线路间距、防焊与线路PAD 间距（将线路与防焊拷贝到一层，然后用Analysis-->DRC 命令检查此层）、防焊条最小宽度、NPTH 处是否有规格大小的防焊挡点（Add-->Flash）。

5.文字处理

检查文字线宽（Info-->Report-->Dcode）、高度（Info-->Measure-->Point-point）、空心直径、文字与线路PAD 间距、文字与成型边距离、文字与捞孔或槽的间距、文字与不吃锡的PTH 间距是否满足制作要求。然后按客户要求添加UL MARK 和DATE CODE 标记。注：

a：UL MARK 和DATE CODE 一般加在文字层，但不可加在零件区域和文字框内（除非有特殊说明）、也不可加在被钻到、冲到或成型的区域。

b：客户有特殊要求或PCB 无文字层时，UL MARK 和DATE CODE 标记可用铜箔蚀刻方式蚀刻于PCB 上（在不导致线路短路或影响安规的情况下）或直接用镂空字加在防焊层上。

6.连片与工作边处理

按所指定的连片方式进行连片（Edit-->Copy）、加工作边。接着加AI 孔（钻孔编辑状态下，Add-->Drill Hit）、定位孔、光学点、客户料号（Add-->Text）、扬宣料号。需过V-CUT 的要导V-CUT 角（Edit-->Line Change-->Fillet，如果需导圆角则用下述命令：Edit-->Line Change-->Chamfer）。有些还要求加ET章、V-CUT 测试点、钻断孔、二此钻孔防呆测试线和PAD、识别标记等。

7.排版与工艺边的制作

按剪料表上的排版方式进行排版后，依制作规范制作工艺边。

8.合层

操作：Tables-->Composites。按Add 增加一个Composites Name,Bkg 为设置屏幕背影的极性（正、负），Dark 为正片属性（加层），Clear 为负片属性（减层）。

在做以上检查合处理工作的同时，应对客户原始资料做审查并记录《D/S&MLB原始资料CHECK LIST》呈主管审核。以上各项检查结果如与制程能力不符，应按规范作适当修改或知会主管处理。

9.输出钻孔和光绘资料

CAM 资料制作完毕需记录原始片、工作片的最小线径、线距和铜箔面积（Analysis-->Copper Area）。

经专人检查后，打印孔径孔位和钻孔报告表，等资料确认合格后即可输出钻孔（File-->Export-->Drill Data）和光绘资料（File-->Export-->Composites）。钻孔输出格式：Leading 3,3 公制（发给铭旺的多层板为Trailing 3,3 公制）。

光绘资料输出格式：Gerber Rs-274-X, Leading 2,4 英制。
CAM（计算机辅助制造）


	


（一）、CAM 的概念

大家已有CAD 的概念，但在光绘工序中必须要有CAM 的概念。因为每个厂的工艺流程和技术水平各不相同，要达到用户的最终要求，必须在制作工艺中做出必要的调整，以达到用户有关精度等各方面的要求，而在CAD 软件中，有许多工艺处理是无法实现的，因此CAM 是光绘生产中必不可少的工序。前面所讲的各项工艺要求，都要在光绘之前做出必要的准备工作。比如镜相、阻焊扩大、工艺线、工艺框、线宽调整、中心孔、外形线等问题都要在CAM 这道工序来完成。

（二）、CAM 工序的组织

由于现在市面上流行的CAD 软件品种繁多（多达几十种），因此对于CAD工序的管理必须首先从组织上着手，好的组织将达到事半功倍的效果。由于Gerber 数据格式已成为光绘行业的标准，所以在整个光绘工艺处理中都应以Gerber 数据为处理对象。如果以CAD 数据作为对象会带来以下问题。

1、CAD 软件种类繁多，如果各种工艺要求都要在CAD 软件中完成，就要求每个操作员都能熟练掌握每一种CAD 软件的操作。这将要求一个很长的培训期，才能使操作员成为一个熟练工，才能达到实际生产要求。这从时间和经济角度都是不合算的。

2、由于工艺要求繁多，有些要求对于某些CAD 软件来讲是无法实现的。因为CAD软件是做设计用的，而没有考虑到工艺处理中的特殊要求，因而无法达到全部的要求。而CAM 软件是专门用于进行工艺处理的，做这些工作是最拿手的。

3、现流行的CAM 软件功能强大，但全部是对Gerber 文件进行操作，而无法对CAD 文件操作。

4、如果用CAD 来进行工艺处理，则要求每个操作员都要配备所有CAD 软件，并对每一种CAD 软件又有不同的工艺要求。这将对管理造成不必要的混乱。综上所述，CAM 工序的组织应该是以下结构，尤其是大中型的企业：
a、所有的工艺处理统一以Gerber 数据为处理对象。
b、每个操作员须掌握CAD 数据转换为Gerber 数据的技巧。
c、每个操作员须掌握一种或数种CAM 软件的操作方法。
d、对Gerber 数据文件制定统一的工艺规范。
e、CAM 工序可以相对集中由几个操作员进行处理，以便于管理。
合理的组织结构将大大提高管理效率、生产效率，并有效地降低差错率，从而达到提高产品质量的效果。

（三）、CAM 所要作的工作

1、焊盘大小的修正，合拼D 码；
2、线条宽度的修正，合拼D 码；
3、最小间距的检查；焊盘与焊盘之间、焊盘与线之间、线条与线条之间；
4、孔径大小的检查，合拼；
5、最小线宽的检查；
6、确定阻焊扩大参数；
7、进行镜相；
8、添加各种工艺线，工艺框；
9、为修正侧蚀而进行线宽校正；
10、形成中心孔；
11、添加外形角线；
12、加定位孔；
13、拼版：旋转、镜相；
14、拼片；
15、图形的叠加处理，切角切线处理；
16、添加用户商标、PCB 板的生产周期、UL 唛头、板材的安全级别及其它应添加的标识；

（四）、CAM 软件

现在常见的CAM 软件有以下几种：
1、PC Gerber（Ver5.62）
PC Gerber 在国内流行较早，得到了较为广泛的应用，尤其在北方较为流行。由于其功能有限，无法满足日益多样化的要求，近年已被逐步淘汰。
其功能如下：
⑴可以同时操作32 个文件。
⑵每个文件都可独立操作，打开、关闭。
⑶可以接受各种Gerber 数据格式（基本格式）：
相对坐标，绝对坐标
公制，英制
前补零制式，后补零制式
⑷多个Gerber 拼于同一个文件中。
⑸以进行各种编辑操作：增加、删除、修改。
⑹可以对以下对象进行操作：
Flash、Trace、Arc、Circle、Vertex、Poly、Text。
⑺可以进行窗口操作（Window）、组操作（Group）
⑻可以修改D 码
⑼D 码有9 种形状：
Round 园型 Square 方型 Rect 矩型
Target 靶型 Thermal 散热盘 Donut 环型
Octagon 八角型 OBlong 椭圆型 Custom 自定义
⑽可以进行数据测量。
⑾可以进行单位变换。
⑿可以进行旋转、镜相、拷贝等拼版拼片操作。
⒀可以进行轮廓线填充。
⒁可以接受1000 个D 码。
其缺陷为：
⑴只能接收自身格式的D 码表。
⑵操作速度慢。
⑶编辑功能不强。
2、View 2001（Ver 3.04）
该软件功能强大，反应速度快，在南方一带较为流行。它除了PCGerber 所具备
的功能外，还具有以下特点：
⑴编辑功能强大：
a.可以锁定某个元素，
b.可以独立关闭Pad 或Trace，
c.可以将Trace 切断，
d.焊盘可以选择单独的颜色,以区别于线条。
⑵显示时放大、缩小操作简单、速度快：
单击鼠标左键放大，
单击鼠标右键缩小。
⑶可以接受扩展Gerber-274X 格式（内含D 码）。
⑷可以对多达100 个文件同时进行操作。
⑸可以接受以下多种CAD 文件产生的D 码表：
Lavenir Mentor optrotech PADS Cadence Interactive
P-CAD pRotel Zuken OrCAD CadStar Eagle Tango EE-Designer
⑹可以将钻孔文件（TXT）转换成Gerber 文件。
⑺可以将Gerber 生成钻孔文件（TXT）。
⑻可以读入HPGL 格式文件，转换为Gerber 文件。
⑼可以将扩展Gerber 分解成基本Gerber 和D 码表。
⑽D 码有15 种
Circular 圆形 Square 方型 Rectargle 矩型
Rounded rect 圆角矩型 Obround 椭圆型 Diamond 菱型
Blank 空白型 Heat relief 梅花型 Target 靶型
Draw Obround 椭圆型 Polygon 轮廓线 Drawn cross 十字型
Nctool 钻孔型 Octagon 八角型 Custom 自定义型
⑾可按受9990 个D 码
⑿可将DMPL 文件转换为Gerber 文件
3、ECAM
功能强大，但因价格昂贵，应用较少。
4、GCCAM
是目前国内流行的软件中，功能最强的CAM 软件。其突出之点是具有了负D 码的
概念，突破了传统的限制。
5、CAM350
这是目前功能最为强大的CAM 软件，能适用广泛的复杂要求。
6、Genesis 2000
具有强大的自动工艺处理功能，适合于大厂使用。在制定了统一的工艺规范后，所有的工艺处理都是自动添加的。
可以自动处理阻焊图；
可以自动修改间距。
7、ParCAM
ParCAM 使用在Win95/Win98/Win2000/WinXP 等操作系统中，对机器的配置要求很低，不需要像Genesis2000 或UCAM 等软件那样，必需要Win2000 系统下才能运行,ParCAM 最低的系统要求只是Windows95 即可运行。
CAD 文件转换成Gerber文件及D码表


	


关于各种CAD 软件转换成Gerber 文件的详细过程请参阅相关的软件操作说明，这里只是根据我们的经验提出一些在转换中应注意的问题。

（一）、Protel for DOS 转Gerber 时应注意的问题
1、D 码匹配的上下限不要设得太宽，这样容易造成偏差太大，致使最小间距无法保证。
2、有时填充区（Fill）转换可能造成错乱。此时应将D 码表中的方型D 码全部删除，再重新转换。
3、在D 码匹配不上而要求手工匹配时，一定要选方式3。
4、在圆弧（arc）转换时，步距（Arc Quality）不要设得太小，否则会造成数据量过大，而且圆弧边缘不光滑。
5、阻焊扩大值可以是负值。
6、圆弧转换可以选择圆弧描述还是直线描述。
Software Arcs: on 为直线描述，转换时用折线近似园弧。
Software Arcs: off 为圆弧描述，真正的园弧描述方式。
对于能够接受圆弧描述的光绘机最好采用圆弧描述。这样做Gerber 文件数据量小，光绘圆弧边缘光滑。
7、当所用D 码超过24 个时，应将G54 选项打开。
8、当单面焊盘需要打孔时，要将Options\Single layer Pad Holes 项目打开。
9、有些工具软件可以由MAT 文件产生完全配置的D 码表。

（二）、Protel for Windows 转Gerber 时应注意的问题。
1、用PFW 可根据PCB 文件自动生成D 码表。但该D 码表中的D 码可能多达数百个，此时应清楚知道你的光绘系统D 码的容量是多少。
2、如果采用的D 码表不是由PFW 自动生成的，以下情况可能导致错误：
①在PFW 中可能有大小为0 的焊盘或线条；
②有Relief 型的焊盘时；
③D 码不配置时。
在以上情况下在MAT 文件中会出现很大的D 码。
3、PFW 中有长八角型焊盘，在转换时D 码表中不应有此种D 码。因为在现行的多数光绘系统中都不接受这种定义，出现这种D 码会导致错误。遇到这种情况时应采用填充方式匹配这种D 码。
4、最好采用用户自定义的D 码表，而不要用PFW 自动生成的D 码表。

（三）PADS 转Gerber 时应注意的问题。
1、PADS 预设的D 码表中的D 码容量太小，需要扩充其容量。
2、有的PADS 文件需要进行铜皮填充后在转换。
3、由于PADS 软件设计线路的特殊性，需要注意观察每图形中要选取哪些元素，避免出现失误造成转出图形错误。

（四）PowerPCB 转Gerber 时应注意的问题。
1、有的PowerPCB 文件需要进行铜皮填充后在转换。
2、PowerPCB 是PADS 的Windows 版本软件，因此在文件的转换中基本与PADS 相同，同样的问题也是需要注意观察每图形中要选取哪些元素，避免出现失误造成转出图形错误。
	


CAM350 中对层的编辑功能基本包括增加/删除层、更改各层顺序、设置层的状态和参数、层组合等。

1.增加层：增加层有两种方法。利用菜单项Edit -> Layers -> Add Layers,或者在左边工具条点击快捷图标，在出现“Number of new layers”后输入需要增加的层数。

2.删除层：Edit -> Layers ->Remove Layers,选择要删除的层。

3.更改各层顺序：有时为了看起来方便想按一定顺序排列各层，可以通过菜单项Edit -> Layers -> Reorder Layers 来实现更改各层顺序的功能。调整顺序时先选中要调节顺序的层，然后移动鼠标到理想的插入点即可，最后按下Renumber
排序。

4.设置层的状态和参数：查看、更改各层信息可以按下热键“Y”或利用菜单项Tables -> Layers,层信息包括层的名字、层的类型、Flash/Draw 颜色、层的状态（On/Off/Ref）、是否当前被激活的层、是否在最前面一层。

5.层的组合：在看Gerber 时经常会需要同时打开某几层一起看，这时，利用某个热键一下子打开几层就会显的非常便捷。CAM350 中“层组合设置功能”就能很好的做到有目的将几层并为一组简单的使用一个热键就能同时打开这组内所
有的层。在CAM350 中有四种不同的层组合选择分别为：User/Layer Stackup/Blind and Buried/MCM Technology。其中，User 为通用的用户定义类型；Layer Stackup 是在拼版过程中使用的层组合设置：Blind and Buried 是配合Netlist 的产生使用的；MCM Technology 是专门针对MCM 技术的基板的Gerber文件。这四种形式下的层组合设置功能可以通过Tables -> Layer Sets 菜单下的四个选择来实现。

由于Layer Stackup/MCM Technology 和我们关系不大，这里仅介绍User和Blind and Buried 两种方式。关于打开组合层的热键，CAM350 是这样规定的，系统默认的热键为数字键0-9，从1 开始为第一个层组合设置，依次类推，0 则代表第10 个层组合设置：当然CAM350 可设置10 个以上的层组合，但只有前10个可以通过热键打开。

首先介绍User 类型：打开Tables -> Layer Sets -> User 菜单会出现“User Layer Sets”对话框：

在左边的"Layer Sets"列表中是层设置的名称及其分配的热键数字。名称是在右边的“name”框中输入的。名字可以使用默认的，也可以自己定义，但是命名中不允许包含空格。一般在“Layer Sets"列表中显示的是“LS1：LyrSet_1<..Hot Key 1",但如果在其他三中类型（Layer Stackup/Blind and Buried/MCM Technology)中已有过设置，则将自动以下一个未使用的热键开始。

如是以“LS1：LyrSet_1<..Hot Key 1"开始的，则表面热键1 已经使用过。接下来依次点击右边数字按钮来加入每个Layer Sets 中包含的层。如点击1 按钮就会弹出“Layer List”的选择框，OK 后该层就显示在1 按钮右侧的框中，点击2按钮加入另一层，重复这个过程直到所有的期望的层都被加入。如果还要在编辑一个层组合只要点击Add 按钮然后重复刚才的操作即可。当然，点击某个Layer Sets 按下Delete就可以删除该设置，也可以选择组内的各层。所有这些设置将被保存在*.CAM 文件中以备下次使用。

接着介绍Blind and Buried 类型：这个功能只有当Gerber 文件中含有盲孔、埋孔信息时才有效。由于这个功能时配合Netlist 的提取而设置的，必须在提取Netlist 之前先设置层，只要先告诉系统Blind and Buried 在哪个层组合，才能提取正确的Netlist。具体实现过程与User 类型类似，打开Tables ->Layer Sets -> Blind and Buried 菜单项，出现“Layer Sets For Blind and Buried Via"对话框：


Layer Sets 的命名及层的加入都和前面讲的一样，只是还要调入两个钻孔文件。点击“Thru Drill”按纽并选择通孔钻孔文件，再点击“Drill Data”选择相应的文件。当“Blind and Buried”类型的层组合设置成功后，在“Layer Table”对话框下方的“By Layer Set”按钮才会生效。
CAM350 基本操作


	


光标移动（Cursor Movement）:

光标的位置大多数情况下是有鼠标控制的，同样键盘上的上下左右箭头也可以控制屏幕上光标安装一个象素或格点来移动。水平移动由左右箭头键控制，而垂直方向的移动则由上下箭头键控制。

循环选择（Cycle Picking）:

在任意一个功能选择模式下如Move 或Copy，可以重复选择编辑对象，这样在执行具体命令前可以选择多个对象，然后所有被选中的对象将作为一个整体在一个框内，然后一起进行编辑。

几种选择方式（Making Selections）：

在使用一个编辑命令时，如Move，可以选择单个对象，也可以同时选择多个对象。单击鼠标左键即可选择单个对象，此时被选中的对象跟随光标移动，并且命令提示行显示“[Move:Single]”：选择多个对象时，只要再同时按下Ctrl键，此时的命令提示行则显示“[Move:Multiple]”，选择完毕后所有被选中的对象被高亮，光标则变成一个包含所有被选中对象的框，如果想去调框中的任意对象只要按住Ctrl 的同时再点击该对象即可，确定好要移动的对象后就可以移动光标到理想的位置。

取消命令（Abort Commands）：

在一个命令执行过程中可以通过单击鼠标右键或按下热键“Esc”终止命令。

CAM350 支持的D 码形状：

Round： 圆形

Square： 正方形

Rectangle： 矩形

Target： 靶标

Thermal： 花孔

Custom： 自定义D 码

Donut： 环形

Octagon： 八边形（不能旋转）

Oblong： 长椭圆形

Triangle： 三角形

Hexagon： 六角形

Ellipse： 椭圆形

Diamond： 菱形
CAM350 中资料的读入


	


在CAM350 中，读入Gerber 文件的方法有两种：

分别为：自动导入和手动导入。

我们多数用自动导入（因为在CAM350 中普遍的D 码其都能自动识别）。而手工导入时操作比较麻烦，主要是在软件不能自动识别其D 码时使用。

自动导入（AutoImport）：

1.操作前必须把所以的Gerber 文件存放在同一个目录中，同时不能有其他文件在这一文件夹中。

首先：自动读入一个Gerber 文件，操作：File -> Import -> AutoImport

2.选择文件所在目录，接着选择单位：English（英制）、Metric（公制），一般为英制。然后按下Next 进行Gerber 文件的读入（注：若你的D 码非RS-274-X 格式时，请不要选择Finsh）。

3.在出现的对话框中将会列出文件的D 码和光栅格式。此时进行正确的设置，按下Finsh 完成。

单位一定要选择English（英制）。对于*.art 文件，可以选择“Apply to All"将设置延伸到其他Gerber 文件。对于Aperture 文件的类型，如果是Rs-274-D要选择“Aperture”,如果是RS-274-X，则选择“RS-274-X no Aperture”.

4.按下Finish 完成后，若出现“Tool Numbers with No;1,2,3,……，则表示钻孔的D 码数据并没有正确输入。这时你可直接按”确定“结束，这并不会有什么影响。

5.如果读入的最后结果有不合理的断、短路或外型尺寸不正确，则表示你读入的Aperture Format 数位或格式有错。这时你就要调整读入时所选的单位格式，直到读到为止（多数PADS 格式都是英制2：3 或公制2：4）。

在Aperture Format 列表中为可自动识别的D 码格式，Gerber Format 为设置当前的底片文件的数据格式类型。

6.正确设置好格式后，就可以正确读入Gerber 文件了。能否正确读入Gerber文件，关键为对Aperture Format 的设置。

注：有时钻孔文件不能自动导入，这时点击File 菜单中Import -> Drill Data 的，接着选择文件所在的路径、单位和格式即可。

手动输入：

a) 标准的gerber file 格式可分为RS-274 与RS-274X 两种，其不同在于：RS-274 格式的gerber file 与aperture 是分开的不同文件。

RS-274X 格式的aperture 是整合在gerber file 中的，因此不需要aperture文件(即，内含D 码)。
File -> Import -> Gerber Data

单击layer 1，输入GERBER 文件，按下Data Format 进行设置。

选择文件格式、绝对坐标还是相对坐标、前导零还是后导零。

“绝对坐标” 和“相对坐标”

绝对坐标：即其坐标以0 坐标为原点，是一个绝对的值。是一个正值。

相对坐标：看其正负，相对坐标总是有正负的，当前坐标总是依照前一坐标递增或递减。

前导零、后导零和不导零：

例：025690 前导零后变为：25690 (Leading)
025690 后导零后变为：02569 (Trailing)
025690 不导零后变为：025690 (None)

Gerber file 的格式：

通常，英制是2：4 格式
公制是3：3 格式

单位：

数据格式：整数位+小数位，常用：
2：3（英制，整数2 位，小数3 位）
2：4（英制，整数2 位，小数4 位）
3：3（英制，整数3 位，小数3 位）

RS-274-D 格式的Gerber 还要设置Aperture 文件，点击OK 后就变成可以设置Aperture 文件的对话框，点击“Aperture File"按钮则弹出一个“Aperture"对话框：和自动导入一样，选择Others 然后根据不同的EDA 软件选择Aperture的格式，然后由“Aperture File"找到该文件的目录，OK 以后即可导入各层数据。

为了读对RS-274 格式的gerber file，你需要有如下概念：RS-274 格式的gerber file 必须同其对应的aperture 文件配合才能正确输入。

CAM350 的AutoImport 功能读RS-274 格式的gerber file 是能自动辨认aperture 的格式的（不同的CAD 软体产生的aperture 的格式也是不同的），而CAM350 的这一功能又是靠其安装目录中.arl 为模板来实现的。

当我们用CAM350 不能正确读入RS-274 格式的gerber file 时，通常是因为不能正确辨认aperture 而造成的，这就需要编写自己的.arl 文件来协助CAM350 正确读入gerber file。

注：能否正确读入GERBER 文件，关键为对Aperture Format 的设置。
CAM350 NC 编辑器其它菜单


	


添加菜单 -- Add ：

Drill Hit 钻孔

Drill Circle 扩孔（G84）

Drill Slot 钻槽（G85）

Drill Text 钻文字（M97、M98）

Mill Path 铣路径（G01）

Mill Circle 铣圆（G32/33）

Mill Slot 铣槽

Mill Tab Tab 位（中断）

这些选项都是在初期使用的比较多，等用刀相当熟练后基本上是通过Gerber to mill 项来自动转换的，配合edit 菜单来修整，不需要通过Add 来一点点的手工添加。

转换菜单 -- Utilities ：

Gerber To Drill Gerber 转钻带

Gerber To Mill Gerber 转锣带

NC Data To Gerber NC 数据转Gerber

Create Drill 生成钻带（做电测时用）

Offset Mill Path 路径偏移（很有用）

Segregate Drills 钻带隔离（区分pt 和npt 孔）

Sort Drill Hits 钻孔数据优化

Sort Mill Paths 铣边数据优化

Step and Repeat Image Order 设置重复排版次序 

图表菜单 -- Tables：

Layers 层菜单（快捷键 Y）

Assign Tool Table to Layer 指定刀具表对应层

Define Mill Tabs 定义Tab 位

New NC Tool Table 新建刀具表

Delete NC Tool Table 删除刀具表

指定刀具表对应层是一个比较重要的选项，如果是通过Add 菜单来手工添加的话，一定要先新建刀具表，在指定刀具表对应层（将层属性改为NC 属性），才能顺利添加数据。
CAM350 NC 编辑器编辑菜单(Edit)


	


Mill Path 铣路径

下面几项功能只对NC 层的NC 数据才有效，对graphic(gerber 层)数据无效，要对gerber 数据进行编辑是要退到CAM Editor 界面下。

Chamfer 倒斜角（只对NC 数据有效）

Fillet 倒圆角（只对NC 数据有效）

Plunge/Extract 更改下刀点（提刀点）

更改下刀点在做锣带时经常用到的，需要注意的是在更改下刀点后，由于cam350 的捕捉功能的原因，要对下刀点处进行再处理，用Edit 菜单下Move Vtx（移动顶点）命令更改后的下刀点进行操作时会发现该处多出一个小段出来，用Delete Set(删除段)命令将其删掉。否则，在实际生产过程中会在下刀处出现一个缺口。

Add Atx at Intersection 在交叉处添加一格顶点这是一项比较实用的功能，使用它在处理锣带制作过程中，无法连续走刀，而需要提刀的时候快速有效的找到两次走刀的共同点。

在生产（gerber to mill）锣带过程中经常会碰刀这种情况：当弧度适当时是可以连续走刀。当出现圆弧变形就需要按下面的操作步骤来对它进行处理了。

先选Utility 里的Offset Mill Path(路径偏移)命令，将已经打好补偿的路径定义为g40 属性。接着用Add Atx at Intersection 命令鼠标左击两条圆弧的交叉处（是NC 层上）会发现在交叉处多出一个顶点，再用Delete Seg(删除段)命令将不需要的段咔嚓掉。准确、快捷，接刀处天衣无缝，这一招很有用。

Segments To Arc 折线转圆弧（只对NC 数据有效）

2. Path Properties 路径属性（补偿方向）

3. Path Direction 路径方向（走刀方向）

4. Drill Hit 更改钻数据的孔径

5. Mill Tab 更改Tab 位

6. Drill Order 钻数据的次序

7. Drill First/Last 定义首、尾孔

8. Mill Order 铣数据次序

9. Compensation 定义补偿

10. Tool 更改刀具

11. Explode 打散
CAM350 V8.0 快捷键


	


A 打开光圈表
C 以光标为中心放大临近范围
D 设置当前激活的D 码
F 切换显示线的填充模式（实填充/外形线/中心线）
G 图形开关
H 所以同类型D 码的元素高亮显示
K 关闭层（当前层除外）
L 指定当前层
M 切换命令行显示方式（记忆模式/命令提示/宏命令提示）
N 切换当前层的正片/负片显示
O 改变走线模式（0/45/90 度）
P 显示上一次缩放大小
Q 查看属性
R 刷新
S 随删格移动开关
T 透视显示开关
U 撤消
V 删格显示开关
W 窗口式放大
X 光标模式切换（短“十”字形、长“十”字形、X 形）
Y 打开层设置对话框
Z 目标选取开关（以光标为中心）
Ctrl U 恢复
+ 放大
- 缩小
Home 全局显示
， 执行上一命令
Esc 结束当前命令（等于鼠标右键）
空格键 等于鼠标左键
Ins 按光标在面版中的位置显示图形
Page Up 放大目标选取框（以光标为中心）
Page Down 缩小目标选取框（以光标为中心）
Ctrl N 新建
Ctrl O 打开
Ctrl S 保存
-------------------------------------------
编辑命令下的功能热键
A 全选
C 框选模式（交叉/不交叉）
I 窗口选择模式（窗内被选/窗外被选）
W 进入组窗口选择模式
CAM350 8.0 图表菜单(Tables)


	


Apertures：光圈表。包括多种类型，含custom（自定义）型。

Next Undefined：跳转到下一个尚未定义的D 码。

Compress：将已定义的D 码排在一起。

Go To Custom：跳转到输入的D 码。

新建一个D 码：

在左边选择一个空的D 码号，然后在右边的Shape 中选择一个D 码的形状，最后输入其数值即可建立起一个新的D 码供使用了。

如：建立一个Round，然后在Diameter 中输入这个圆的直径就可以了。

删除D 码：Edit->Delete 移动光标选择要删除的元素即可完成。

改变D 码：进入Aperture Definition，选择新的D 码形状替代当前正使用的D码形状就行了。

Custom：（自定义D 码）

建立自定义D 码：在Tools -> Cap Editor 中直接创建自定义光圈，这些自定义D 码形状包括：散热盘、三角形、钻石形、斜角长方形、异形、子弹形、多边形或任何你所需要到所想要的图形，最后保存即可。在D 码表中，通过改变D 码类型来替代你所想改变或替代的D 码形状，这是非常方面实用的。

2. Padstacks：焊盘堆（生成网络时会将同一孔位的所有焊盘组成一焊盘堆）。

3. Layers：层属性表。定义每层的属性为自动拼板和生成网络的前提条件（快捷键 Y）。

4. Composites：复合层定义。Dark（正片）、clear（负片）。

5. Layers mapping：层的映射表。

6. Nc tool tables：钻孔刀具表。
CAM350 8.0 工具菜单(Tools)


	


CAM Editors：默认的编辑器。用来导入和输出数据。还包括DRC、拼版及其他制造预备步骤。

2. CAP Editors：光栅编辑器。作用：建立或修改一个自定义D 码。后缀为：CLB

3. Part Editors：零件编辑器。作用：建立或修改一个新的零件。后缀为：PLB

4. Flying Probe Editors：飞针测试编辑器。

5. Bed Of Nails Editors：针床编辑器，即电脑测试架。

6. NC Editors：数控钻、铣编辑器，即CNC 数据。用于NC 程序的制作生成。
CAM350 8.0 分析菜单(Analysis)


	


Analysis：对于与电性能的相关检测先生成网络再制作。

2. Acid traps：分析查找弯角距离太小或角度小于要求值的铜线。

3. Copper slivers：文件中的残铜。

4. Mask slivers：文件中的阻焊碎片。

5. Find solder bridges：检测阻焊桥。

6. Find starved thermals：测试热焊盘的开口宽度。

7. Silk to solder spacing：检测丝印至线路的间距。

8. Drc：设计规范检查。

该指令在检测中使用较多，主要可作为线距、盘距、线距盘、各焊盘外径及空盘相对应等检测项目，以支持CAM 的主要工作。

9. Check Net：网络测试。

主要用于针对当前图形与原生成的网络做开路检测，即两层不在同一网络的plane 层不同时为热焊盘确保不短路。

10. Copper area：铜皮面积。

11. Compare layers：层比较。用于文件自检。

12. Check mill：检测铣边。检测外形补偿与实际宽度或弧度是否有冲突。

13. Check dirll：检测钻孔。检测有无重孔、叠孔、孔距离。
CAM350 8.0 转换菜单(Utilities)


	


Draw to custom：线转自定义D 码。

Draw To Symbol：画线转符号（排版时用）。

2. Draw to flash：可将某些线转换成焊盘。

Automatic：自动

Interactive：交叉

3. Polygon conversion：多边形转换。

Draw To Raster Poly：线转换成光栅。

Raster Poly To Vector Poly：光栅转换成矢量。

Draw To One-Up Border：定义单元Border。

4. Draw To raster poly：将非矢量的区域转换成矢量。

5. Netlist extract：生成网络。

Clear Silkscreen：清除丝网标记。

6. Data optimization：数据优化。

Remove isolated pads：删除孤立焊盘。使用该指令时要注意其是否会造成断线开路。

Remove redundant pads：删除重叠的焊盘。

7. Teardrop：泪滴型焊盘。为了增加焊盘和线路的接触面积以降低因开路造成的报废。

8. Over/under size：统一放大/缩小各元素的尺寸。会重新产生新D 码，并不会改动图形的尺寸比例。

9. Panelization：排版编辑器。

10. Convert Composite：转换复合层。

11. Composite To Layer：复合层合到层。
CAM350 8.0 信息菜单(info)


	


Query 查询图形属性

All：显示当前元素的所有信息（快捷键 Q）。

Net：显示当前网络的所有信息。

Dcode：显示当前D 码的所有信息。

2. Find：查找。

3. Measure 测量距离

Point to point：测量点到点的距离。左上角的L0、L45、L90 表示其角度。

Object to object：测量两元素间的距离。

4. Report 报告

Dcode：显示所有层或指定层的D 码表。

Nc Tool：显示钻孔报告。
CAM350 8.0 查看菜单(View)


	


1. Window：窗口放大查看（快捷键 W）。

W 键可与许多操作指令配合使用，可做窗口内和窗口外的选择（快捷键 I），也可做选择某元素部分或全部的切换（快捷键 C）。

2. All：查看整个图形（快捷键 Home）。

3. Redraw：刷新（快捷键 R）。

4. In：放大（快捷键 +）。

5. Out：缩小（快捷键 -）。

6. Pan：平移显示（快捷键 Insert）。此项操作用于逐屏检查，注意技巧。

7. Composite：合成。

8. Back side：反面。

9. Rotate：旋转。

10. Tool bar：显示工具条。

11. Status bar：显示状态栏。

12. Layer bar：显示图层条。
CAM350 8.0 添加菜单(Add)


	


Flash：增加焊盘。

2. Line：增加线。

3. Polygon：增加多边形或铜皮。

铜皮有非矢量（Raster）和矢量（Vector）两种，可设置填充铜皮与边框线的距离。注意用于填充的边框必须为封闭。

4.Polygon Void：截除填充部分。

Line：线
Circle：圆

5. Text：增加字符，可以在任意一层上添加文字说明。

Style 按钮是用来设置文本的字体、大小、对齐方式、字间距的。在D 码列表中选择合适的D 码，在层列表中选择文本所在的层。字符设置也可在Text Style 中进行。

6. Rectangle：增加方框。

7. Circle：增加圆。

Center-Radius：中点-半径
3-Points：3 点

8. Arc：增加弧。

Center-Angle：中点-起点
3-Points：3 点
2-Points：2 点
CAM350 8.0 编辑菜单(Edit)


	


编辑菜单之一：

1.undo： 撤消。也就是返回上一步（快捷键 U）。

2.redo： 恢复。如果你undo 用错了，就可以用redo 恢复（快捷键 Ctrl U）。

3.Move： 移动。

选择MOVE 命令后，再按A 是全选，按I 是反选，按W 是框选（按W 就是要用鼠标把整个元素都框上才能选中），按C 的效果很特别（按C 只要选中该元素的一小部分就能选上，）什么都不按的话就是单元素选择。
这里对操作界面进行具体介绍：

左上角的“数字：数字”：就是栅格的间距，可自己设置比例（按V 就可显示栅格，按S 就是光标随删格移动）。
“L 数字”：设置角度，有0，45 和90 可以选择（快捷键 O）。
“Move To Layer”：移动到其它层。选择你要移动到的层，可以是一层，也可是多层。

紧跟着的就是筛选元素的类型，有drw，flsh，drill，mill 等（不同的命令有不同的类型可选择，有时还会有VIA 等选项）。

“Filter”：筛选元素。

Ddoces：筛选D 码。填上你所要D 码的号数，两个以上用逗号隔开。
0 或空白 = 全选
#，#，…… 包含
#：#，…… 范围
-#，-#：#，…… 不包含
Tool References：筛选钻孔。
Polygon Filter：多边形过滤。
Text Filter：文字过滤。

"Prev"：功能跟按W 的效果差不多，也是框选，但它有一个特性，就是可以记住上一次曾经选过的东东，请活用这功能！
“SelectAll”：跟按A 的全完一样，也就是全选啦。

右下角那“数字：数字”就是X,Y 的坐标系数（可更改），这是一个能令操作精度变得更高的命令，请多加运用。双击后出现一个小界面框，旁边的“Abs”是绝对坐标，“Rel”是相对坐标。“Abs”是指以origin 为基准，“Rel”则是以你在主画面中最后一次鼠标左键操作为基准。

坐标系数的右边显示的是单位MM 或MILS，更改单位在“Settings”菜单里。

4.Copy： 复制。Copies：这里填上你要复制的倍数，To Layers：选择你要复制到的层，可以是一层，也可是多层。

5.Delete：删除。

6.Rotate：旋转。有几种角度可以选择，也可以自定义旋转角度。

7.Mirror：镜像。Vertical 是X 轴镜像，再按一下就变成Horizontal 是Y 轴镜像。

编辑菜单之二： 

1. Layers（层操作）：每一个PCB 板基本上都是由线路层、阻焊层、字符层、钻孔数据层、DRILL 层所组成的，在CAM350 中，每载入一层都会以不同的颜色分别开，CAM350 提供了强大的层处理功能。如：层对齐、增加层、层排序、层
删除、层缩放等。

Add layers：增加层，在左边工具条有快捷按钮。

Remove：删除层。按Compress 可自动识别无用层。

Reorder：重新排列层。可通过鼠标来调整，然后点Renumrer 重新排列层号。

Allign：定位。用于层与层之间的对齐。

Snap pad to drill：将焊盘与焊盘对中。可选择Tolerance 即在坐标相差多少之内的可做对中移动。

Snap pad to drill：将焊盘向钻孔对中。

Snap drill to pad：将钻孔与焊盘对中。

Scale：比例。用于设置层的缩放比例。

2. Change（更改）：在这里可重新设定每个元素的D 码，字体的大小、样式，坐标的原点等。

Dcode：更改D 码。

Text：文字。

Text Style and Contents：文字风格和内容。

Explode：打散命令。如字符可打散为线，客户自定义光圈及铜皮均可打散成线。

All：打散所有。

Custom ：打散自定义D 码。

Vector Polygon：打散矢量多边形。

Text：打散文字。

Sectorize：圆弧转折线。

Origin：设置坐标原点。

Space Origin：绝对原点。

Grid Origin：网格原点。

Datum Coordinate：数据坐标。

Panelization Anchor：排版原点。

3. Trim using（修剪）：这个操作只对当前有效的线元素有作用，常用于调整一些线段，如修剪等。

操作时要先选择修剪的分界线，左键选择，可以连续选择成多顶点窗口状。右键确定，再左键点选需要修剪的Line。
注意：圆弧是不能被修剪的，需要修剪时只有先把它转成折线，然后再修剪。

Line：通过一条线作为修剪线的部分。

Circle/arc：通过圆或弧来作为修剪边界的部分。

4. Line change 线的更改

Chamfer：倒斜角。
Fillet：倒圆角。
Join segments：可合并多段线条。
Break at Vtx：在顶点处打断。
Segments To Arcs：折线转圆弧。

5. Move vtx/seg：移动顶点/分节

6. Add vertex：增加顶点

7. Delete vertex：删除顶点

8. Delete segment：删除分节
CAM350 8.0 文件菜单(File)


	


1. new ：新建（快捷键 Ctrl+N）。

2. open：打开（快捷键 Ctrl+O）。

3. save：保存（快捷键 Ctrl+S）。

4. save as：另存为。

5. merge：合并两PCB 文件。可将两层排列方式基本一致的板做拼接，若掌握熟练可拼接文件用于菲林绘制。

6. Import：导入文件。

Autoimport：自动导入文件。
系统自动为选择的文件做光圈表匹配，若有匹配不正确或无法匹配的则可做调整，选择其他光圈编译器或重新编辑编译器并做检查。

Gerber data：导入Gerber 文件。对于RS274-X 文件自带D 码即可将文件调入，而对于RS274-D 文件则通过调整文件格式来调试到显示正确的图形。

Drill data：导入钻孔数据。同样通过格式调整来调试图形正确性。

Mill data：导入铣边资料。

Dxf：一种文件格式，一般有客户提供此类文件作为说明。

Aperture table：光圈表。
当确定光绘文件调入正确，而光圈表不匹配的情况可使用该指令来调整光圈表使用的编译器。

7. Export：导出文件。
Composites：复合层输出。
Drill data：钻孔数据。
Mill data：铣边数据。

8. Print：文件打印。
Setup printer：打印机设置。
Print display：打印预览。

9. Setup：系统设置。

Preferences：参书选择。
可设置优先缓存区，如：undo 恢复键功能；自动备份的功能，但常规下不做自动备份。

Paths：路径。定义系统显示的输入输出及其它一些环境文件所在的默认路径。

File extensions：设置输入输出文件扩展名的默认值。

Colors：设置显示的颜色。可根据个性进行设置。

Photoplotter：对光绘程序中指令的识别进行设置。

有客户设计软件生成的文件在该选择不同时将会有不同识别程度，不要轻易更改其间参数。当发现文件中有不明设计的圆弧，可通过选择Ignore arcs with same start/cnd points 调试后与客户确认，或发现文件中焊盘线处于未填实的情况可通过将Interpolated arc if no G74/G75 由Quadran 调至360 Degrees，切记当调试后再做其他板之前请务必调回原默认状态。

Nc-mill machine：为铣边文件设置默认格式。

Nc-drill machine：为钻孔文件设置默认格式。

Save defaults：将当前环境设置为默认环境。在每次使用New 指令即可进入该默认环境。

10. Exit：退出。

	


